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 В лабораторной работе № 1 по дисциплине «Методы обработки данных 

дистанционного зондирования» рассматриваются инструментарий и программное 

обеспечение для предварительной обработки и анализа данных ДЗЗ, полученных с 

различных космических аппаратов 

 Методические указания предназначены для магистров по направлению 010400.68 

―Прикладная математика и информатика‖, обучающихся по программе «Математические и 

компьютерные методы обработки изображений и геоинформатики». 
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Цель работы – изучение методов обработки и анализа космических снимков; 

получение навыков работы со специальным программным обеспечением; применение 

навыков обработки изображений к исследованию и анализу космических снимков. 

 

 

1.  ПОДГОТОВКА К ВЫПОЛНЕНИЮ ЛАБОРАТОРНОЙ РАБОТЫ 

1.1.  Инструкции к выполнению лабораторной работы. 

1. Ознакомьтесь с  руководством пользователя программного обеспечения 

обработки данных ДЗЗ.  

2. Поместите все примеры в отдельно созданную  директорию. 

3. Предварительно прочитайте задание и пример выполнения, затем повторите все 

действия, следуя инструкциям. 

4. Рекомендуется выполнять задания последовательно, так как знание предыдущих 

заданий позволят выполнить последующие. 

1.2.  Настройка программного обеспечения. 

 Для корректной работы в программе требуется настроить параметры работы в 

приложении. 

1. Откройте диалог настроек приложения пунктом меню File -> Options…или 

кнопкой  панели инструментов. 

2. Откройте закладку Paths диалога Options, в которой  прописываются пути к 

рабочим файлам необходимым для некоторых операций привязки и 

трансформирования. 

Если путь или файл не существует, то поле ввода подсвечивается красным 

3. В закладке Paths в поле  Orbit file mask задайте путь к файлам орбитальных 

элементов NORAD в формате TLE через кнопку , указав маску файлов, 

например ―D:\NORAD\*.tle‖ (рис.1). 

 

 Файлы орбитальных элементов необходимы для проведнеия геометрической 

коррекции и трансформации. Они либо предоставляются операторами съемочных 

систем, либо в случае данных Modis Terra/Aqua находятся в свободном доступе в 

Интернете. 
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Рис.1. Настройка закладки Paths в диалоге Options 

В поле Default world map пропишите два векторных слоя WORLD_Boundary.shp 

и WORLD_Coastline.shp, которые при открытой панели File Manager  будут 

автоматически накладываться на «Регион». Слои находятся в установочной 

директории Scan Magic в папке Map. 

В поле CSV file path укажите путь через установочную директорию Scan Magic к 

папке CSV, где находятся служебные файлы, содержащие параметры датумов и  

эллипсоидов. 

4. Перейдите в закладку Display , которая отвечает за параметры визулизации и 

вывода изображения на экран. Оставьте все параметры по умолчанию. 

5. В закладке Language  диалога Options  в выпадающем меню Select available 

Language должен быть выбран (или стоять по умолчанию) английский язык 

интерфейса приложения-  English. 

6. Закройте дилог Options кнопкой ОК. 

7. В случае появления окна-уведомления с просьбой перезапустить приложение 

для принятия указанных настроеек, выйдите из него и откройте программу 

заново. 
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2. ВЫПОЛНЕНИЕ ЛАБОРАТОРНОЙ РАБОТЫ 

2.1. Просмотр контуров изображений на карте мира и  открытие 

изображений.  

 Просмотр контуров географически привязанных изображений открытых 

директорий на карте мира в равнопромежуточной цилиндрической проекции 

происходит в окне Региона, его корректная визуализация возможна только после 

запуска панели File Manager.  

1. Для открытия горизонтальной панели File Manager  нажмите на кнопку 

Manager на панели Extended Toolbar. Если не произошло автоматического открытия 

окна Региона совместно с панелью File Manager , тогда загрузите его командой меню 

File -> Create Region  или  кнопкой  на  панели инструментов 

В программе может быть открыто только одно окно Региона. 

2. Изображения из текущей директории выводятся в панели File  Manager в виде 

списка с некоторыми основными атрибутами. В поле Folder панели File Manager с 

помощью кнопки  выберите директорию «Scandata» с примерами изображений к 

упр. После чего на карте мира отобразятся контура границ привязанных снимков.    

3. В списке изображений выделите курсором снимок LISS2.hdf, затем 

масштабируйте участок месторасположения снимков на карте мира кнопкой   на 

панели инструментов. Заметьте, что помеченный  снимок из списка имеет красный 

контур границ, в отличии от всех остальных. 

4. Чтобы  открыть снимок LISS2.hdf, щелкните по нему два раза мышкой на  

панели File Manager  или подведите к нему курсор, нажмите на правую кнопку мыши  

и в появившемся контекстном меню выберите команду Open (рис.2). 

Чтение любого формата в программе происходит напрямую, без 

преобразования данных, через команду меню File -> Open… или кнопкой  на панели 

 

Рис.2. Выведенный список изображений из папки «Scandata» на панели Manager 
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5. Не закрывая окна с выведенным изображением LISS2.hdf, переходите к 

выполнению следующего упражнения. 

6. Закрыть изображения или изображение можно через меню File командой Close , 

закрыть активное окно, командой Close All,  закрыть все открытые окна, и  командой 

Close and Delete File, закрыть активное окно и удалить подгруженный в него файл. 

2.2.  Работа с гистограммой изображения. Алгоритмы коррекции 

изображения.  

1. Выполните упражнение «Просмотр контуров изображений на карте мира и  

открытие изображений». 

2. Впишите в  полноэкранный вид окна снимок LISS2.hdf по высоте с помощью 

инструмента . 

3. Откройте инструментальную  панель View, вызываемой кнопкой View на 

панели Extended Toolbars. 

4. На панели View  реализована группа элементов Algorithm, отвечающая за 

преобразование снимков различных съемочных систем с учетом специального 

алгоритма коррекции. Для коррекции изображения LISS2.hdf  системы IRS  

включите опцию  IRS 1C/1D LISS correction в группе элементов Algorithm. 

5. Постройте RGB-модель снимка LISS2.hdf, включив группу элементов True 

Color на панели View. Из раскрывающегося списка каждого цветового канала 

R, G, B выберите последовательно каналы «Band3», «Band2» и «Band1».  

Следует помнить, что гистограмма строится только для той части 

изображения, которая в данный момент отображается  в окне просмотра. Границы 

гистограммы определяются в момент отрисовки изображения в окне просмотра.  

6. Удостовертесь, что в выпадающее меню Range стоит правильный 

радиометрический диапазон отображаемой гистограммы 8 bit. 

7. С помощью выпадающего списка Channel осуществите выбор канала по 

которому будет набираться гистограмма. Визуализируйте на гистограмме сразу 

все 3 канала синтезируемого изображения закладкой RGB, затем 

воспользуйтесь поочередно кнопками быстрого контрастирования: , 

выполняет линейную функцию контрастирования, и  , производит 

эквализацию графика гистограммы. Просмотрите  получившиеся результаты.  
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Не забудьте отключить эквализацию, отжав кнопку  после ее 

применения. 

8. Напротив кнопки  на панели View задайте 1 процент в элементе , 

затем нажмите на кнопку , чтобы  выполнить быстрое контрастирование 

видимой части изображения с  автоматическим определением границ 

диапазона гистограммы и  отсечением одного процента  ее площади по краям. 

Отобразите в поле графика гистограммы через список Channel друг за другом 

каналы Red, Green или Blue RGB- модели и отметьте произошедшие 

изменения. 

 Минимальные и максимальные границы диапазона контрастирования также 

определяются    вручную: для исходной гистограммы движками под гистограммой, 

для преобразованной гистограммы движками слева от гистограммы, соотвественно 

их числовые значения будут отображаться  в  элементах Input или Output 

 (рис.3). 

  

Рис.3. Визуализация снимка LISS2.hdf посредством инструментальной  панели View 

Выходной результат этого упражнения будет использован в упражнении 
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«Взаимная навигация окон просмотра». 

2.3.  Инструменты навигации. Взаимная навигация окон просмотра.  

1. Выполните упражнение «Работа с гистограммой изображения. Алгоритмы 

коррекции изображения». Создайте новое окно с тем же изображением 

LISS2.hdf с помощь пункта меню Окно -> Новое окно или с помощью кнопки 

  на панели инструментов. 

2. Визуализируйте дубликат LISS2.hdf  идентично его аналогу. 

3. Для перемещения по  видимой части изображения в любом окне просмотра 

изображения LISS2.hdf используйте  инструмент «лапка» . С помощью 

кнопок панели инструментов приложения произведите следующие операции: 

 - выделите  курсором на поле окна  фрагмент изображения. 

 - измените  масштаб отображения вдвое относительно текущего масштаба. 

 - измените масштаб отображения вдвое относительно текущего масштаба. 

 - задайте  изображение в окне по ширине. 

 - задайте изображение в окне  по высоте. 

 - возврат к предыдущему масштабу и положению. 

 - установите масштаб отображения 1:1. 

 Аналогичные действия можно активировать с помощью главного меню 

программы  Image , которое отвечает за отображение и масштабирование 

изображений. 

4. Просмотрите  видимую  часть  изображения в окне  через опции 

автоматического прокручивания. Выделите фрагмент изображения в нижней 

правой части изображения инструментом . Далее зайдите в главное меню 

программы  Image  и выберите пункты   Auto Scroll Upwards, прокрутка вверх 

окна, затем  Auto Scroll Downwards, прокрутка вниз окна 

5. Работа с окнами изображений. Выровняйте изображения в каждом окне по 

высоте. Установите рабочие: 

 - «каскадом». 

 - по горизонтали. 
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 - по вертикали. 

6.  Далее  выровняйте два рабочих окна со снимком LISS2.hdf по вертикали 

кнопкой  на панели инструментов. Сверните, если есть,  окна просмотра, 

содержащие другие  изображения, и повторно нажмите на кнопку . 

7. Выровняйте в каждом окне снимки по высоте средством  масштабирования  

. Сделайте одно из них активным и увеличьте любой фрагмент его 

изображения с помощью кнопки .   

8. Вызовите инструмент связывания окон просмотра пунктом меню Окно -> 

Навигация или кнопкой  на панели инструментов и щелкните им по полю 

неактивного окна. 

9. В результате видимая часть активного окна будет отображаться 

прямоугольником локализации в другом окне просмотра. Передвижение по 

области локального просмотра изображения в более крупном масштабе 

производится «лапкой»  (рис.4). 

 

Рис.4. Взаимная навигация окон просмотра снимка LISS2.hdf 

Не закрывая результатов этого упражнения, переходите к выполнению 

следующего. 
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2.4.  Работа с произвольным фрагментом изображения.  

В программе реализовано несколько способов задания    фрагментов изображения. 

произвольной формы. 

1. Основой для выполнения данного упражнения служат результаты упражнения 

«Инструменты навигации. Взаимная навигация окон просмотра». 

2. После синхронизации двух окон просмотра изображения LISS2.hdf включите 

режим выбора фрагмента произвольной области кнопкой   на панели 

инструментов или через пункт меню Image -> Select Fragment и задайте его по 

границам прямоугольника просмотра локальной области в любом окне 

просмотра изображения 

Изменить границы фрагмента можно подведя курсор к одной из границ 

фрагмента, тогда он превратится в стрелку перемещения. 

3. Чтобы более точно задать границы фрагмента и знать его линейные размеры в 

метрах, откройте инструментальную панель Info, вызвать которую можно 

нажатием на кнопку Info на панели Extended Toolbars.  Кроме того, отключите 

режим задания фрагмента произвольной области, отжав  кнопку   на панели 

инструментов. 

4. На панели Info  помимо общих сведений об изображении, представлена группа 

элементов Planar, показывающая планарные координаты местонахождения 

курсора в поле окна. Координаты групп элементов Geographic и Map 

отображаются в зависимости от режима привязки изображения. 

5. Сделайте активным окно с изображением LISS2.hdf в более крупном 

масштабе, где в видимой части окна визуализирован участок снимка. 

6. Наведите курсор на верхний левый угол окна и запомните его планарные 

координаты  Pixel  и Line, затем кнопкой  группы элементов Fragment 

панели Info выведите диалоговое окно Fragment и запишите  в поле Top номер 

строки (значения Line)  и в поле Left номер столбца (значения Pixel) пикселей 

верхнего левого угла фрагмента. Закройте диалог кнопкой  OK. Повторите 

операцию, аналогично предыдущей, указав значения уже правого нижнего угла  

фрагмента в диалоге Fragment.  Результатом станет отображение фрагмента в 

каждом из окон просмотра изображения (аналогично рис.4.). 
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7. Так как снимок LISS2.hdf  является геопривязанным изображением, измерьте 

высоту установленного фрагмента в метрах инструментом  на панели Info. 

Для этого активируйте его нажатием по кнопке, затем щелкните курсором 

мыши в верхнем левом углу фрагмента и не отпуская левую клавшу мыши 

проведите  линию до конца нижнего левого угла. В окне вывода Ground 

Distance (Meters) отобразится измеренное расстояние в метрах, в окне вывода 

Image Distance (Pixels) – в пикселях изображения. После измерения расстояния 

инструмент автоматически отключится. 

8. После установления границ фрагмента, вырежите его из изображения с 

исходным набором спектральных каналов в новое окно программы в качестве 

нового изображения через команду меню Edit -> Cut Image Fragment As a New 

Window. Настройте его гистограмму, воспользовавшись инструментальной 

панелью View. 

Вырезанный фрагмент изображения будет использован в следующем 

упражнении. 

2.5.  Работа с векторными слоями.  

1. Откройте  из директории «Scandata» снимок LISS2.hdf съемочной системы 

IRS. Настройте его в режиме RGB-модели (см. «Работа с гистограммой 

изображения. Алгоритмы коррекции изображения»). 

2. Запустите инструментальную панель управления отображением векторных 

карт Map  с помощью кнопки Map диалоговой  панели  Extended Toolbars. В 

открывшейся инструментальной панели добавьте векторные карты кнопкой . 

В диалоге Open Vector layers зайдите в  директорию «Scandata»,  из папки  

«DSW»  выберите и загрузите в программу следующие векторные слои: 

 DCW_Drainage.line 

 DCW_Hypsography.line 

 DCW_PopulatedPlaces.point 

 DCW_Railroads.line 

 DCW_Roads.line 

 Для открытия векторных слоев можно также воспользоваться пунктом 

меню Image -> Add Vector Layers… или кнопкой  на панели инструментов. 
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3. В случае загрузки ненужной векторной карты, например, 

DCW_Hypsography.line,  в списке векторных слоев панели Map  выделите ее 

курсором, щелкните по ней правой кнопкой  мыши и в появившемся меню 

выберите Remove. 

4. Проследите, чтобы все оставшиеся слои были выведены в поле окна 

изображения,  в этом случае напротив каждого слоя должен быть установлен 

флажок. Это же действие можно выполнить, выделив невидимые  записи 

списка  с нажатой клавишей Ctrl, затем щелкнуть по ним правой кнопкой 

мыши и в появившемся меню выбрать закладку Visible. 

 

Рис. 5. Задание стиля отображения векторных слоев на панели Map 

5. Задайте стиль отображения каждого векторного покрытия через редактируемые  

поля Color и Size в таблице их характеристик, которые  отвечают за управление 

цветом и размерами векторных объектов слоя (рис. 5)  

Подберите  для каждого слоя: 

 DCW_Drainage.line,   Color  - синий цвет, Size – 1 

 DCW_PopulatedPlaces.point,   Color  - бирюзовый  цвет, Size – 3 

 DCW_Railroads.line, Color  - черный цвет, Size – 1 

 DCW_Roads.line, Color  - оранжевый  цвет, Size – 2 

6. Список векторных карт с подобранными атрибутами сохраните во внутреннем 

формате  программы под именем «LISS2.sms»  в папку «Scandata». Для этого с 
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нажатой клавише Shift выделите все записи в списке, щелкните по ним правой 

клавишей мыши и в выпадающее меню укажите закладку  Create Map Set File.  

7. Так как снимок LISS2.hdf с наложенным на него векторными покрытиями 

будут исходными данными для следующего упражнений «Географическая 

привязка. Привязка к карте», поэтому их не следует закрывать. 

       Удалить все векторные слои с изображения можно кнопкой  , либо через 

пункт меню Image -> Remove All Vector Layers или кнопкой   на панели 

инструментов.  

2.6.  Технология привязки изображений.  

1. Подготовьте исходные данные, выполнив упражнение «Работа с 

векторными слоями». Результатом которого должен быть подгруженный   

снимок  LISS2.hdf и открыт подготовленный набор векторных слоев 

LISS2.sms. 

2. Визуализируйте снимок  LISS2.hdf в натуральных цветах. Откройте 

инструментальную панель View, вызываемой одноименной кнопкой на 

панели Extended Toolbars. Чтобы получить синтезированное изображение 

LISS2.hdf в натуральных цветах, в группе элементов Algorithm панели View 

активизируйте опции IRS 1C/1D LISS correction  и IRS LISS natural color.  

3. После коррекции снимка  LISS2.hdf на панели View проведите 

масштабирования  изображения по высоте инструментом , затем 

напротив кнопки   задайте 1% отсечения площади гистограммы по ее 

краям в элементе , затем нажмите на кнопку , чтобы  выполнить 

быстрое контрастирование видимой части изображения (рис. 6.). 

Откройте инструментальную панель управления географической привязкой 

Geo кнопкой Geo на панели Extended Toolbars. Снимок LISS2.hdf имеет режим 

привязки Geolocated Image, поэтому по умолчанию  на панели Geo  включен 

переключатель ”GEOLOCATED IMAGE” и заданы параметры, в выпадающем 

списке Method закладка Orbit/Sensor Analytic Model  и  в группе  Orbit закладка Use 

From Current Image File.   
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Рис 6. Визуализация снимка  LISS2.hdf  в натуральных цветах с проведением 

быстрого контрастирования видимой части изображения 

4. Для осуществления привязки изображения к векторной карте включите 

группу элементов Correction на панели Geo. После чего станет активной 

кнопка , с помощью нее перемещайте набор векторных слоев по снимку, 

находя соответствие между векторными объектами и  объектами на снимке. 

При отпускании кнопки мыши геопривязка снимка будет перерассчитана с 

учетом вычисленных поправок произведенной трансформации. 

5. Не сохраняйте результат трансформации кнопкой , так как эта привязка 

достаточная грубая и в дальнейшем будет произведена прецизионная 

коррекция данного изображения с использованием опорных точек. 

6. После совмещения растрового и векторных слоев, вызовите 

инструментальную панель Map  одноименной кнопкой на  панели Extended 

Toolbars.  На панели Map задайте   географическую координатную сетку 

снимка, поставив флажок  напротив  кнопки .  

Активизация самой кнопки выведет диалог Set Geographic Grid 

Parameters, в котором должны  быть указаны следующие параметры 

визуализации  географической сетки широт и долгот: шаг сетки Grid Step  

30 минут (30‖), цвет сетки Latitude/Longitude Grid Color  серый, цвет 
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подписей  Show Text Labels with Color белый с обязательным включением 

данной опции (рис. 7.) 

 

Рис. 7. Определение параметров визуализации  координатной сетки снимка 

LISS2.hdf в диалоге Set Geographic Grid Parameters 

7. Подтвердите внесенные изменения в диалог Set Geographic Grid 

Parameters кнопкой ОК. Просмотрите получившийся результат (рис. 8). 

 

Рис 8. Вид преобразованного снимка LISS2.hdf с нанесенным на него векторным 

покрытием и координатной сеткой 
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8. Удалите все векторные слои с изображения кнопкой  , либо через пункт 

меню Image -> Remove All Vector Layers или кнопку  на панели 

инструментов. Снимите флажок напротив опции Snow Geographic Grid. 

Не закрывайте снимок LISS2.hdf, он потребуется при выполнении следующего 

упражнения «Мозаика изображений. Мозаика многозональных снимков» 

2.7.  Простейшая мозаика многозональных снимков.  

1. В программе должны быть открыты только снимки 

landsat_1.tif l и landsat_2.tif и окно Региона (см. 

«Просмотр контуров изображений на карте мира и  

открытие изображений»).  

2. Сделайте окно Региона активным, затем вызовите 

инструментальную панель  Region посредством 

одноименной кнопкой на панели Extended Toolbars.  

Перед проведением операции составления мозаики все 

изображения необходимо геометрически совместить.  

3. На панели Region в закладке Image из списка  

Available Image перенесите в  список Selected Image  

все открытые изображения с помощью кнопки  

. 

4.  Выберите способ комплексирования каналов 

«Synthesis from multiple-band images», нажав на 

кнопку . Затем укажите число каналов 

синтезируемой мозаики на панели Region в поле 

Bands   равное 3.  В результате  в таблице  Spectral 

bands position, в столбце  Regional channel 

выводится  три  результирующих канала мозаика 

(рис. 9). 

5. В раскрывающемся списке элемента Resampling  

выберите  тип интерполяции – Bilinear 

Interpolation.  

6.  Выделите курсором в списке Selected Images один 

 Рис. 9. Панель Region  в 

закладке Image 3-х 

канальной мозаики 
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из снимков, например,  landsat_2.tif. 

7. Возвратитесь к таблице Spectral bands position. В 

столбце Image Band  щелкните мышкой по любой 

редактируемой строке значений, и откроется  список 

каналов снимка landsat_2.tif, в  котором выберите 

порядковый номер канала идентичный номеру 

канала мозаики в столбце Regional channel, 

исключив  значения «None» (рис. 10). 

8. После перейдите к  списку Selected Images и 

курсором выделите следующий снимок – 

landsat_1.tif.  Повторите все действия по вложению 

его каналов в каналы мозаики, как и для снимка 

landsat_1.tif .     

 Рис. 10. Размещение 

каналов снимка 

landsat_1.tif в выходные 

каналы мозаики 

9. Каждый снимок должен быть отображен, поэтому элемент Visible  должен быть 

включен у каждого снимка. 

10. На панели Region перейдите в закладку  Projection. Включите  группу элементов 

Border. Нажмите  кнопку  и в появившемся контекстном меню выберите пункт 

Autodetect, отвечающим за автоматический расчет географических границ 

Региона.  

11. В поле  элемента Resolution (meters) задайте  пространственное разрешение 

Региона и мозаики 24 метра (по исходному пространственному разрешению 

снимков). 

12. В строках  группы элементов Map Projection Parameters (List) выберите проекцию 

Региона и мозаики через систему разнотипных параметров: в списке Projection – 

проекцию UTM, в списке Zone – закладку Autoselect, в строке Hemisphere  - 

North, эллипсоид Ellipsoid и систему координат Datum -  WGS84. 

13. Нажмите  на кнопку Apply. После процедуры расчета для корректного 

отображения мозаики впишите ее по высоте  в окно Региона инструментом  .  В 

окне Региона отрисовываются контура границ изображений, участвующих в 

мозаике 

14.  Удалите также векторные слои в окне Региона, перейдя в  инструментальную 

панель Map (см. «Работа с векторными слоями»). 
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15. Настройте RGB-модель мозаики, при этом  в элементе управления SubImage, 

находящейся рядом с панелью инструментов, выберите из раскрывающего списка 

строку Region. Зайдите в закладку View и настройте   гистограмму мозаики. (см. 

«Работа с гистограммой изображения. Алгоритмы коррекции изображения»). 

Доступ к характеристикам изображений, трансформированных в Регион, 

осуществляется также посредством элемента управления SubImage. При работе с 

Регионом этот элемент управления позволяет выбирать из списка название 

анализируемого изображения. При выборе строки Region работа через панель 

Extended Toolbars осуществляется со всем изображением Региона. При выборе 

имени одного из снимков в элементе управления SubImage, участвующих в мозаике, 

действия выполняются только с его изображением, что позволяет выполнить 

поочередно индивидуальную настройку гистограмм изображений, участвующих в 

создании мозаики, через элементы визуализации и представления изображений на  

панели View. 

16. Сохраните созданную многоканальную  мозаику через опцию  File -> Save Image 

As…, которая позволяет сохранить исходный набор и порядок  каналов, исходное  

радиометрическое разрешение и контрастирование.  В диалоге Save Image As 

задайте название файла «landsat_mosaic» и сохраните его в новую директорию 

«Save», тип файла выберите с расширением *.tif.   

17. Просмотрите полученный результат посредством пункта меню File -> Open…или 

кнопкой  на панели инструментов. 

 

Рис. 11. Визуализация мозаики в естественных цветах 
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2.8.  Мозаика одноканальных снимков.  

Открываем из директории «Scandata» из папки «LANDSAT1» одноканальные 

изображения LANDSAT1_B10.tif, LANDSAT1_B20.tif, LANDSAT1_B30.tif, из папки 

«LANDSAT2» - LANDSAT2_B10.tif, LANDSAT2_B20.tif, LANDSAT2_B30.tif. Для 

этого  поставьте флажок в окошке  на панели Manager, что позволит добавить в 

список изображения во всех поддиректориях указанной папки «Scandata» (см. 

«Просмотр контуров изображений на карте мира и  открытие изображений»).  

Перед проведением операции составления мозаики все изображения необходимо 

геометрически совместить. Каждое одноканальное изображение  относится к 

определенному участку спектра: LANDSAT1_B10.tif и LANDSAT2_B10.tif  к голубому 

участку, LANDSAT1_B20.tif и LANDSAT2_B20.tif – к зеленому, LANDSAT1_B30.tif и 

LANDSAT2_B30.tif-  к красному. 

1. Сделайте окно Региона активным, затем вызовите 

инструментальную панель  Region посредством 

одноименной кнопки на панели Extended Toolbars. 

2. На панели  Region в закладке   Image из списка  

Available Image перенесите в  список Selected Image  

все открытые изображения с помощью кнопки  

. 

3. Выберите способ комплексирования каналов 

«Synthesis from single-band images» или сшивка из 

нескольких одноканальных изображений одного 

мультиспектрального, нажав на кнопку . Затем 

укажите число каналов синтезируемой мозаики на 

панели Region в поле Bands = 3.  В результате  в 

таблице  Spectral bands position, в столбце  Regional 

channel выводится 3  результирующих канала (рис. 

12). 

4. Затем в выпадающем списке Resampling  выберите  

тип интерполяции – Bilinear Interpolation. 

5. Элемент Visible, отвечающий за визуализацию 

 

Рис. 12. Размещение 1-

канальных изоб. в выходные 

каналы мозаики 
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каждого изображения,   должен быть включен. 

6. Выделите курсором в списке Selected Images одно 

из изображений, например,  LANDSAT1_B10.tif. 

7. В таблице Spectral bands position в столбце  Image 

Band  щелкните мышкой по редактируемой строке 

значений напротив первого канала мозаики. После 

чего будет выведен список, в котором выбирается  

один канал изображения LANDSAT1_B10.tif, 

исключая  значения «None». В другие каналы 

мозаики устанавливаются значения «None».  

8. Выделите курсором в списке Selected Images   

изображение LANDSAT1_B20.tif. После чего  канал 

изображения LANDSAT1_B20.tif занесите во 

второй канал мозаики, а в оставшиеся каналы 

подставьте  значение «None».  В третий канал 

мозаики подставьте канал изображения 

LANDSAT1_B30.tif, не забывая об установке 

значения «None» в других. 

9. По изложенной выше схеме для оставшихся 

изображений нужно подставить в 1-ый канал 

мозаики канал LANDSAT2_B10.tif, во 2-ой канал –

LANDSAT2_B20.tif,  в 3-ий – LANDSAT2_B30.tif. 

10. После задания содержания каналов выходной 

мозаики, перейдите  в закладку  Projection 

11. Включите  группу элементов Border. Задайте  

рассчитываемую область Региона с помощью 

фрагмента,   границы которого пропишите вручную 

в  группе элементов Border. Границы фрагмента 

верхнего левого угла в географических координатах 

равны 55°55’ 00‖ N и 19°45’00‖ E, нижнего правого - 

54°40’00‖ N и 21°50'00‖ E. 

 

Рис. 13. Задание на панели 

Region 

 

Рис.14. Определение 

параметров проекции  на 

панели Region в закладке  

Projection 
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12. В поле  элемента Resolution (meters) задайте  пространственное разрешение 

Региона 30 метров (разрешение исходных изображений). 

13. В строках  группы элементов Map Projection Parameters (List) выберите проекцию 

Региона и мозаики через систему разнотипных параметров: в списке Projection – 

проекцию UTM, в списке Zone – закладку Autoselect, в строке Hemisphere  - North, 

эллипсоид Ellipsoid и систему координат Datum -  WGS84. 

14. Нажмите  на кнопку Apply. После получения  мозаики, масштабируйте ее  по 

высоте   в окне Региона кнопкой   на панели инструментов.  Удалите также 

векторные слои в окне Региона. (см. «Работа с векторными слоями»). 

15. Настройте RGB-модель мозаики в естественных цветах, при этом  в элементе 

управления SubImage, находящейся рядом с панелью инструментов, выберите из 

раскрывающего списка строку Region. Зайдите в закладку View и настройте   

гистограмму мозаики каждого канала. 

2.9.  Улучшение пространственного разрешения (Fusion). 

Приложение позволяет выполнить операцию слияния данных разного 

пространственного разрешения (Resolution Merge). Целью данной операции является 

получение синтезированного цветного изображения высокого пространственного 

разрешения с  использованием  панхроматического  изображения с высоким 

пространственным разрешением и многозональное изображение с низким 

пространственным разрешением.  

1. Откройте  4 одноканальных изображения: три из них  LANDSAT2_B10.tif, 

LANDSAT2_B20.tif, LANDSAT2_B30.tif имеют разрешение 30 метров, а 

LANDSAT2_B80.tif -15 метровое панхроматическое изображение. Каждое 

одноканальное изображение  относится к определенному участку спектра: 

LANDSAT2_B10.tif  к голубому участку, LANDSAT2_B20.tif – к зеленому, 

LANDSAT2_B30.tif-  к красному. 

Для корректного проведения операции слияния необходимо выполнить 

предварительную привязку используемых изображений, в данном случае это не 

требуется. 

2. Затем создайте 4-канальную мозаику снимков с параметрами: 
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 На панели Region в закладке   Image надо выбрать способ комплексирования 

каналов “Synthesis from singe-band images”,  с количеством выходных каналов 

равным 4. В первых трех задайте 30-метровые одноканальные изображения, в 

четвертом –панхроматическое изображение. 

 в закладке Projection укажите в строках: Projection – проекцию UTM, Zone – 

Autoselect,  Hemisphere  - North,  Ellipsoid и Datum -  WGS84. В  элементе  

Resolution (meters) задайте пространственное разрешение Региона равное 15 

метрам, это разрешение панхроматического  одноканального изображения.   

 Нажмите на кнопку Apply 

Схема выполнения мозаики представлена в упражнении «Мозаика одноканальных 

снимков». 

3. Настройте RGB модель окна Региона  с помощью панели View, на которой в 

группе элементов True  Color для синтеза RGB-модели в естественных цветах, 

укажите правильных порядок каналов созданной мозаики, исключая 

панхроматический канал с 15-метровым разрешением. Зайдите в закладку View и 

настройте   гистограмму мозаики каждого канала (рис 15). (см. «Работа с 

гистограммой изображения. Алгоритмы коррекции изображения»). 

4. Параметры слияния задаются в группе 

элементов Resolution Merge в нижней части 

панели View, которую необходимо 

активировать. В элементе Method выберите 

один из  алгоритмов слияния -  Arithmetic 

Transform, а в элементе High Resolution 

Channel укажите  панхроматический канал. 

5. Настройте опять гистограммы мозаики, 

выбирая поочередно цветовые каналы  RGB- 

модели через список Channel 

 

 

Рис.15. Вкл. группа элементов 

Resolution Merge в нижней 

части инструментальной панели 

View 

6. Сохраните получившийся результат в режиме “Save View As” , который 

экспортирует изображение с параметрами отображения текущего окна просмотра, 

то есть с текущим цветосинтезом (RGB) или выбором каналов (Grayscale), 

текущим масштабом и  контрастированием, радиометрическим разрешением 8 

бит/пиксель. Перед проведением операции сохранения необходимо учитывать, что 



 23 

текущий масштаб определяет разрешение сохраняемого изображения. Для того 

чтобы  сохранить с улучшенным разрешением  изображение, то текущее окно 

просмотра должно иметь масштаб  1:1, установленным с помощью кнопки 

масштабирования .  

7. Посредством пункта меню File -> Save View As… в появившемся диалоговом окне 

сохраните изображение в новую директорию «Save» с  именем выходного файла 

«Fusion»  и форматом записи с расширением *.tif.  В результате будет  сохранено 3 

канала мозаики с 15-метровым разрешением и настроенной цветовой палитрой. 

  

Рис. 16. Левое изображение дано с улучшенным 15-метровым пространственным 

разрешением, правое изображение с 30-метровым 

2.10.  Работа  с  опорными точками. 

1. Откройте в программе только два изображения посредством пункта меню File -> 

Open…или кнопкой  панели инструментов: LISS1.hdf, привязываемое 
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(трансформируемое) изображение, с которого будут набираться опорные точки, 

и Landsat_mosaic.tiff, эталонное изображение.  Установите рабочие окна с двумя  

изображениями по вертикали, нажав на  кнопку   панели инструментов. 

2. Настройте изображения в панели View, для снимка LISS2.hdf  используйте два 

метода коррекции IRS 1C/1D LISS correction и IRS 1C/1D LISS correction (рис. 

17). (см. «Работа с гистограммой изображения. Алгоритмы коррекции 

изображения» ). 

  

Рис 17. Загрузка в программу и настройка отображения изображений LISS2.hdf и 

Landsat_mosaic.tiff. 

Перед проведением операции установки опорных точек должны быть соблюдены 

условия:  

 при установке опорной точки в окнах просмотра привязываемого и эталонного 

растров  не должны быть активированы любые кнопки с панели инструментов 

приложения 

 при установке опорной точки всегда должно быть активно только окно 

трансформируемого изображения 

 опорные точки должны быть набраны  с максимальной степенью точности 

 опорные точки должны быть нанесены равномерно в центре и по краям 

изображения. 
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3. Выведите инструментальную панель GCP через диалоговую панель  Extended 

Toolbars нажатием на одноименную кнопку (рис. 18). Найдите  на 

трансформируемом растре характерную точку и соответствующую ей точку на 

эталоне с помощью инструментов навигации и масштабирования на панели 

инструментов.  

 

Рис. 18. Вид установленной опорной точки на привязываемом и эталонном растрах. 

4. Нажмите на кнопку Pick Up на панели GCP, далее   на  трансформируемом 

растре установите курсор на найденную точку и  щелкните левой кнопкой  

мыши, затем переместите курсор в соответствующую точку на эталоне, и еще раз 

нажмите левую кнопку мыши. Опорная точка будет установлена, и отобразится в 

виде вектора смещения на привязываемом изображении (рис.). 

5. При удалении неправильно поставленной опорной точки выполните следующие 

действия: 
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 Для отображения поставленной точки на изображениях выделите ее курсором  в 

списке, тогда ее положение на снимке будет отмечено желтым цветом. 

 При удалении одной ОТМ из списка щелкните по ней правой кнопкой мыши и 

нажмите на Remove в выпадающем меню. При удалении нескольких ОТМ 

выберите их из списка при нажатой клавише Ctrl или Shift на клавиатуре и  

щелкните на  отобранном  списке правой кнопкой мыши, в появившемся 

выпадающем меню нажмите на  Remove. 

6. Наберите определенное количество опорных точек,  соблюдая рассмотренные  

выше условия их нанесения. Чтобы  оценить степень покрытия ОТМ площади  

привязываемого снимка, выделить все ОТМ в списке GCP  курсором мыши с 

нажатой клавишей Shift (рис. 19).  

 

Рис 19. Инструментальная панель GCP 

7. Сохраните созданный  список  ОТМ через опцию Save GCP List на панели GCP. 

Приложение выведет стандартный диалог сохранения с типом файла формата 

ASCII GCP file с расширением *.gcp, назовите файл  «GCP_ LISS_map». 

 Убрать сохраненный список можно кнопкой Remove GCP List. 

8. Не закрывая изображения и сохраненного списка точек, переходите к 

выполнению упражнения «Привязка по технологии изображение к 

изображению». 
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Рис. 20. Вид опорных точек на привязываемом и эталонном растрах. 

2.11.  Технология привязки изображения к изображению. 

Технология привязки основывается на коррекции или задании  системы 

координат трансформируемого снимка по координатам опорных  точек, считанных 

с эталонного изображения. Поэтому предварительно должны быть нанесены 

опорные точки на трансформируемом изображении, сколотые с эталонного растра. 

1. Выполните упражнение «Работа  с  опорными точками» и воспользуйтесь 

полученными результатами. 

2. С помощью элемента управления Polynomial Order на панели GCP задается 

степень полинома, который будет использоваться при геометрической коррекции 

изображения с учетом заданных ОТМ, выберите в нем закладку Autoselect.  

3. Обновите привязку снимка LISS2.hdf  с использованием опорных точек 

посредством пункта меню File -> Refresh Geolocation или кнопкой  панели 

инструментов. Аналогичная кнопка имеется и на инструментальной панели Geo. 

После привязки  геопривязанного снимка «Geolocated Image» LISS2.hdf, режим  его 

привязки не изменится. 

4. Проверьте результат произведенной трансформации с помощью Региона, 

совместив в нем каналы изображений  LISS2.hdf и Landsat_mosaic.tiff. Чтобы 

активировать инструментальную панель Region откройте окно Региона кнопкой 
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 на панели инструментов. Если окно Региона не было запущено с менеджером 

изображений, то в нем ничего не будет отображено. 

5. На инструментальной панели Region задайте мозаику изображений с выбором 

следующих параметров: 

 в закладке Image укажите способ комплексирования каналов «Synthesis from 

single-band images»,  в поле  Bands  задайте  2 выходных канала мозаики. Внесите 

по одному любому каналу изображений LISS2.hdf и Landsat_mosaic.tiff  в 

каждый канал мозаики. (см. «Мозаика одноканальных снимков»). 

 в закладке  Projection в группе элементов Border  выберите  Autodetect, в 

элементе  Resolution (meters)  поставьте 24 метра,  проекцию Региона и мозаики в 

списке Map Projection Parameters (List) задайте UTM с авто-определением  Zone, 

в строке Hemisphere  укажите  North, эллипсоид и систему координат должны 

быть   WGS84. (см. «Мозаика одноканальных снимков»). 

6. Нажмите  на кнопку Apply. После получения  мозаики, масштабируйте ее  по 

высоте   в окне Региона кнопкой   на панели инструментов.  Затем настройте 

Регион с помощью панели  View, в которой выберите группу элементов True 

Color. В появившемся списке цветовых каналов R, G, B выберите 

последовательно каналы «Band2», «Band1» и «Band1», выполните настройку их 

гистограмм через список Channel.  («Работа с гистограммой изображения. 

Алгоритмы коррекции изображения»).  

7. Оцените качество произведенной привязки снимка LISS2.hdf к изображению 

Landsat_mosaic.tiff, воспользовавшись средствами навигации (рис. 21).  
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Рис. 21. Качество привязки. 

Отметьте, что режим привязки у снимка LISS2.hdf изменился на Mapped Image на 

панели Geo 

8. Оцените привязку изображений. Если снимки точно привязаны друг другу, то 

все пространственные объекты не размазаны на изображении, т.е. не 

дублируются(кроме случая изменения во времени самых объектов) и не 

смещены. В противном случае следует вернуться к этапу установки ОТМ. 

9. Закройте изображения без сохранения и удалите опорные точки. 
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4.  ПОРЯДОК  ВЫПОЛНЕНИЯ  ЛАБОРАТОРНОЙ  РАБОТЫ 

4.1. Исходные данные 

 Космические снимки с различных космических аппаратов с различным 

разрешением (Terra, Spot, Landsat) – исходные данные предоставляется 

преподавателем;  

 Орбитальные данные для привязки снимков – файлы расписаний и орбитальные 

данные предоставляется преподавателем;  

 Векторные слои для привязки изображений (города, страны, береговая линия) – 

векторные карты предоставляется преподавателем; 

 Параметры настойки программного обеспечения.  

4.2. Общий план выполнения работы 

1. Изучить описание программного обеспечения. 

2. Изучить правила настройки ПО. 

3. Выполнить поэтапно все упражнения из раздела 6 (Варианты). 

4. После выполнения каждого упражнения сохранить копию экрана 

(alt+printScrn). 

5. Составить отчет о выполненной работе. 

6. Сдать отчет преподавателю, получить зачет по работе. 

http://www.scanex.ru/
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4.3. Содержание отчета  

Отчет по работе должен содержать:  

 Набор изображений экрана, соответствующих каждому из упражнений. 

 Описание параметров преобразований. 

 Списки точек привязки. 

 

5. КОНТРОЛЬНЫЕ ВОПРОСЫ 

1. Карта мира и просмотр изображений. 

2. Коррекция по гистограмме. 

3. Работа с фрагментами. 

4. Технология привязки. 

5. Построение мозаик.  

6. Повышение разрешения.  

7. Опорные точки. 

8. Технологии привязки изображений.  
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6. ВАРИАНТЫ ЗАДАНИЙ  

 

Все студенты выполняют поэтапно упражнения с набором изображений, 

предоставленным преподавателем. 

6.1.  Этапы выполнения работы 

1. Работа с данными КА TERRA. Пространственное разрешение 1000, 500 и 

250м. 

Исходные данные: 

AM1_41051_070906072701.pds – "сырые данные" 

MOD021KM.A0709060728.hdf – данные с разрешением 1000м, прошедшие 

геолокацию и калибровку. 

MOD02QKM.A0709060728.hdf – данные с разрешением 250м, прошедшие 

геолокацию и калибровку. 

Задание: 

  Открыть сырые данные в режиме разрешения 1000м. Попробовать что-

нибудь отобразить (см. п. 2.1); 

  Отобразить в режиме RGB каналы с номерами 7,5,3 (см. п. 2.1, 2.3); 

 Понять, почему надо отображать именно эти каналы, чтобы изображение 

было в натуральных цветах (см. п. 2.2, 2.3); 

  Настроить хорошее контрастирование (см. п. 2.2); 

  Подгрузить векторные карты (см. п. 2.5); 

  Установить привязку по орбитальным данным (07_09_06.tle) (см. п. 2.6); 

 Открыть MOD021KM.A0709060728.hdf. Настроить отображение. 

Подгрузить карты (см. п. 2.1-2.3, 2.5); 

  Убедиться что привязка лучше, помехи скомпенсированы; 

 Открыть MOD02QKM.A0709060728.hdf (см. п. 2.1); 

 Выделить фрагменты на MOD021KM и MOD02QKM (см. п. 2.4); 

  Создать Регион в виде 4-х канальной мозаики: в 1-е 3 канала загрузить 

из MOD021KM (7,5,3 каналы) в 4-й загрузить 1-й канал из MOD02QKM. 

Разрешение 250м, проекция Гаусса-крюгера (6 градусные зоны), зона - 

автовыбор, эллипсоид крассовского, датум - пулково 1942 (см. п. 2.1, 2.3, 
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2.7, 2.8); 

 Повысить разрешение первых 3-х каналов с использованием 4-го 

(арифметическое преобразование -  см. п. 2.9); 

 Сделать принтскрин с повышенным разрешением, .pds и векторными 

слоями. 

 

2. Работа с данными КА LANDSAT. Пространственное разрешение 30м. 

Исходные данные: 

landsat_1.tif, landsat_2.tif – данные с разрешением 30м, прошедшие геолокацию 

и калибровку (см рис. 23). 

Задание: 

 Открыть изображения (см. п. 2.1).  

 Настроить отображение (RGB-3,2,1 каналы). Создать регион, на котором 

будут оба изображения (см. п. 2.2, 2.7, 2.11). 

 Сделать принтскрин региона. 

 

3. Работа с данными КА SPOT4. Пространственное разрешение 20м. 

Исходные данные: 

spot4.tif - данные с разрешением 20м, прошедшие геолокацию и калибровку (см 

рис. 22). 

Задание: 

 Открыть изображение (см. п. 2.1).  

 Подгрузить карту береговой линии (см. п. 2.5).  

 Расставить опорные точки и скорректировать привязку (см. п. 2.10). 

 Создать регион, отобразить карту, убедиться, что привязка стала лучше 

(см. п. 2.1, 2.3, 2.5, 2.10). 

 Сделать принтскрин региона. 
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Рис. 22. Изображение с КА Spot-4. 

 

 

Рис. 23. Изображение с КА Landsat. 
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